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Software License Agreement
Graphtec Corporation ("Graphtec") permits you to use the software distributed together 
with this agreement ("Software") based on the terms and conditions prescribed below, 
and you shall also agree to be bound by such terms and conditions before you may 
use the Software.

1. Copyrights
Each of the copyrights of the Software and all the information contained in the printed 
documentation such as manuals, distributed together with the Software, are owned 
by the individual or corporate body indicated in the Software or the appropriate 
documentation.

2. Right of use
You may install and use one copy of the Software on one computer at a time.

3. Duplication or Modification
(1)	 You may duplicate the Software for backup purposes only. In this case, the right 

(i.e., copyright) that covers the Software must be displayed in every duplication.
(2)	 You shall not disassemble or decompile the Software in order to merge, amend, 

or adapt it in any way.

4. Use by third parties
It is a contravention of the license agreement to permit a third party to use the 
Software, or transmit or transfer it to a third party, or otherwise dispose of it for a third 
party.

5. Warranty
(1)	 If the Software cannot be operated normally due to physical failure of the storage 

media, contact Graphtec or your Graphtec vendor. If the physical failure is due to 
a fault of Graphtec, the storage media will be replaced free of charge.

(2)	 The replacement in the above paragraph is the only warranty undertaken by 
Graphtec.

(3)	 Graphtec supplies the Software "as is". Graphtec or the supplier does not 
warrant any performance or results obtained through use of the Software or 
the documentation accompanying it. Either expressly or implicitly, Graphtec 
or the supplier does not warrant any absence of invasion of the right of a third 
party, merchantability, and/or fitness for a particular purpose. In whatever case, 
Graphtec or the supplier assumes no responsibility for incidental, derivative, 
or special damages, even if the Graphtec vendor has notified the user of the 
possible occurrence of such damages. In addition, Graphtec or the supplier 
assumes no liability for rights asserted by a third party.

About The Registered Trademarks
• Any company or product name in this manual is the registered trademark or 

trademark of the respective company.
• All copyrights of the Scanning Arts 2 for WIN software and this manual are owned by 

Graphtec.

Cautions And Conditions Concerning This Manual
• The whole or part of the contents of this manual may not be duplicated or reproduced 

without the permission of Graphtec.
• The contents of this manual and the specifications for the product are subject to 

change without prior notice.
• We have made every effort to guarantee the contents of this manual and product; 
however, should you find any unclear information or possible errors, please contact 
Graphtec or your Graphtec vendor.

• Graphtec assumes no liability with respect to this manual or for any effect arising 
from operating the product even if the manual contains any unclear information or 
possible errors as mentioned in the previous paragraph.
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2	 Setup
This chapter describes how to set up the Scanning Arts 2 for WIN software.

2.1	 Installing Scanning Arts 2 for WIN

2.1.1	 Opening the "Start" Window
When the Scanning Arts 2 for WIN CD-ROM is inserted in the computer's CD-ROM 
drive, the "Start" window is displayed as shown below.  
If the "Start" window is not displayed, open "My Computer" and double-click "CD 
drive". If the "Start" window is still not displayed after performing the above procedure, 
execute "S-ARTS2Setup.exe" from the CD-ROM.

When the "Start" window is displayed, click "Install Scanning Arts 2 for WIN".

2.1.2	 Installing Scanning Arts 2 for WIN
Installation Procedure
(1)	 When the installation program is launched, the following window is displayed first 

of all. Click the "Next" button to continue.

1	 Introduction
1.1	 Introduction
Scanning Arts 2 for WIN was designed to enable full color copies of large-format 
drawings, posters, etc., to be made easily. In addition to making copies, Scanning Arts 
2 for WIN can also be used to scan documents to create files, and to print files that 
have been scanned.

1.2	 Features
Simple copy function
The clear, easy-to-understand menus enable even first-time users to make copies easily.
Professional-level color adjustment functions
The built-in Document Type creation mode enables specific setup parameters for each 
document type to be loaded using a one-touch operation.
Scan functions
Large-format drawings, posters, etc., can be scanned and saved as digital data. File 
names are appended automatically to enable fast, continuous scanning.
Print functions
Data saved to files is sent to a printer for output.
sRGB/Adobe RGB Functions
CSX510/530/550 can use sRGB or Adobe RGB Color Space to scan.
Note:	 Output results in copy mode differ greatly depending on your printer driver’s color 

adjustment function. Please set your printer driver’s color adjustment function and 
scan settings in accordance with your desired output.

1.3	 Operating Environment
•	Operating system: Windows XP Service Pack 2 or later, Windows Vista, Windows 7

Note:	This software is supported on 32bit/64-bit Windows systems.
•	CPU: Pentium 4. Core 2 Duo
•	Memory: 1 GB or more
•	Monitor: 1024 x 768 pixels, True Color (DPI setting: Normal size) or more
•	Disk capacity: 40 GB or more
•	Mouse
•	Keyboard
•	Interface*1:	USB 2.0 interface *2 (that comes standard with your computer)  

	 Network interface (10Base-T, 100Base-TX, 1000Base-T)
*1:	Use of the USB 2.0 interface is recommended for the scanner connection.
*2:	Be sure to use the USB 2.0 interface that comes standard with your computer.
Note:	 In order to use this software, please log on as an Administrator user. Access to some 

of the functions will be restricted if you log on as a regular user. 
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(2)	 The "License Agreement" window is displayed next.

	 Read the agreement carefully. To continue the installation, select "I accept the 
terms in the license agreement" and then click "Next".

(3)	 The "Destination Folder" window is displayed next.

	 Select a folder for installation.  
Unless there is a problem such as insufficient space, usually there is no need to 
change from the default folder displayed to a different folder. If there is no change 
to the installation destination, click "Next" to continue.

(4)	 The "Ready to Install the Program" window is displayed next.

	 Click the "Install" button to start copying the files.

(5)	 When the files have been copied, the "InstallShield Wizard Completed" window is 
displayed.

	 Click the "Finish" button to complete the Scanning Arts 2 for WIN installation 
procedure.
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3	 Using the Scanning Arts 2 for WIN Software
This chapter describes how to launch the Scanning Arts 2 for WIN software and how to 
exit the program. It also provides descriptions of the Scanning Arts 2 for WIN window 
configuration.

3.1	 Launching and Exiting Scanning Arts 2 for WIN
Launching Scanning Arts 2 for WIN
When the Scanning Arts 2 for WIN software is installed, Scanning Arts 2 for WIN is 
added to "All Programs" in the Start Menu. Click [Start] > [All Programs] > [Scanning 
Arts 2 for WIN] > [Scanning Arts 2 for WIN] to launch the software.

Exiting Scanning Arts 2 for WIN
To exit the Scanning Arts 2 for WIN program, click the "Quit" button that appears at the 
bottom right of the "Select Mode" window or at the bottom left of each Mode window.

3.2	 Scanning Arts 2 for WIN Window Configuration
The buttons and displays used in the Scanning Arts 2 for WIN window configuration 
are described in this section.

3.2.1	 Select Mode Window
This window prompts you to select one of the modes. It is the first window displayed 
when the Scanning Arts 2 for WIN software is launched.
* Modes............ The Scanning Arts 2 for WIN software has three main functions: Copy, 

Print and Scan.  
These functions are referred to respectively as the COPY MODE, 
PRINT MODE, and SCAN MODE. 

"Select Mode" window.

	 COPY  
Displays the COPY MODE window.

	 PRINT  
Displays the PRINT MODE window.

	 SCAN  
Displays the SCAN MODE window.

	 Help  
Displays the Help window.

	 Setup  
Displays the Setup window.

	 Quit	  
Quits the Scanning Arts 2 for WIN program.
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3.2.2	 Main Window
After a mode has been selected in the Select Mode window, a Main window is displayed for the selected mode.  
The configuration of the Main window is the same for all three modes, and comprises a Preview Area, a Common Area, and a Setup Area.

Preview Area 

Common AreaCommon Area

Setup AreaSetup Area

Please see the following sections for 
details on the Setup Area buttons:

Chapter 4 COPY Mode: 
Copy mode button descriptions

Chapter 5 PRINT Mode: 
Print mode button descriptions

Chapter 6 SCAN Mode: 
Scan mode button descriptions

•Preview Area 

Slider

1:1
*Displays the image with 1 dot 

on the screen representing 
1 pixel

Preview
*Displays the 

scanned-in image

Move

Save
*Saves the image

Enlarge Area
*Enlarges the display 
of the specified area

FitEnlargeReduce

•Common Area
Displays the 

Select Mode window

Displays the 
Help window

Quits the Scanning Arts 2 
for WIN program

The Execute button 
for each mode:

Copy
Print
Scan
CancelDisplays the 

Setup window
Displays the Printer Setup 

window for the printer

Confirms the 
scanner connection

Specifies the 
number of copies

•Setup Area
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3.2.2.1	 Common Area

The buttons that are common to each mode are located in this area.
Note:	 There may be minor differences depending on the mode selected.

	 (Copy, Print, Scan)/Cancel 	
This is the Execute button.  
The button label varies according to the mode selected.
COPY mode.....Copy
PRINT mode.....Print
SCAN mode......Scan

	 When this button is clicked, the label changes to "Cancel", and becomes 
the Cancel button.
Note:	 For further details on the Execute button, see the function 

explanations for each mode.

	 Number of Copies 	
This button is only displayed in the COPY mode and the PRINT mode. 
The "Copies" button specifies the number of copies to be made. Click 
this button to display the "10Key" window. Click the relevant numeric 
keys to input the desired number, and then click the "OK" button. 

	 10Key window

	 The number of copies that can be specified is a number within the range 
that can be specified for the printer that is being used.
Note:	 If data that exceeds the size limit is output in COPY mode, multiple 

copies cannot be created. In this case, a "Size limit exceeded. Cannot 
output the second and subsequent prints." message is displayed 
after the first copy is output. 	
To avoid this type of situation, either reduce the output length or 
lower the Print Quality setting.

	 Scanner connection confirmation  
This icon is only displayed in the COPY mode and the SCAN mode.  
When this icon is clicked, a scanner connection check is performed. The 
scanner status is indicated by the color of the icon. If the color is red, an 
error message is displayed.
Red:	If the scanner is not connected, or if a document has not been 

loaded in the scanner, the icon is displayed in red.  
Check the error message to find the cause and solve the problem.
Note:	 If the scanner is not connected, perform checks using the 

following methods: 	
Check whether the scanner is connected correctly to the 
computer, and then click the scanner button. If the red color is 
still displayed, check that the scanner power switch is on, and 
then exit Scanning Arts 2 for WIN. 	
Turn off the power to the computer, and then turn it back on 
again. Launch Scanning Arts 2 for WIN.

Green: The scanner is connected.
Flashing (orange): Checking the connection.
Note:	 If a CS600/CS610 Series scanner is being used, "Document 

Thickness" is displayed at the left of the scanner connection 
confirmation icon.

	 Printer Setup  
This icon is only displayed in the COPY mode and the PRINT mode.  
Click this icon to display the Properties window for the printer driver 
that was selected in "Printer Select" on the "Printer" tab in the "Setup" 
window.
Note:	 The Printer Setup icon is always displayed in green. Unlike the 

scanner connection confirmation icon, colors are not used to display 
the printer status.

	 Setup  
Displays the Setup window.

	 Back to Mode  
Displays the Select Mode window.

	 Help  
Displays the Help window.

	 Quit  
Quits the Scanning Arts 2 for WIN program.
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3.2.2.2	 Preview Area

The tools for changing the size of the image displayed in the Preview window and for 
saving the changes are located in the Preview Area.

	 Preview  
Scans the document, and displays the image in the Preview Area.

	 Save  
Saves the image data displayed in the Preview Area to a file. The image 
size is the size specified in the Document Size setting.  
One of the following windows is displayed when the "Save" button is 
clicked.
•	If "Full Screen" on the "General" tab in the "Setup" window is not 

checked, the Windows "Save As" window is displayed.

Methods for specifying the Save As destination
The procedure for the Save As destination is as follows:
(1)	To change the file name of the image to be saved, input a new name 

in the File name box.
(2)	To change the drive or folder to which the image is saved, specify 

the drive or folder in "Save in".
(3)	To change the file format of the image to be saved, select a new 

format from the "Save as type" list.  
The file extension of the new format will be changed to the default 
character string.

Click the "Save" button to save the image data.
•	If "Full Screen" on the "General" tab in the "Setup" window is checked, 

the "Save" window is displayed.

Methods for specifying the Save As destination
The Save As destination can be specified in three different ways as follows:
(1)	Use the computer keyboard to directly input the Save As destination 

in the "Save as" box.
(2)	Click the "Browse" button to display the Browse window and specify 

a folder.
(3)	Use the "File Name" tab to specify the file name; the "Save in" tab to 

specify the folder, and the "Save as Type" tab to specify the file format.
Note:	The file name and folder must have been registered in advance to 

enable the "File Name" and "Save in" tabs to be used to specify the 
Save As destination. In the Setup window, register the file name 
and folder name in the File tab's "Register File Name" window and 
in the "Register Folder" window. For further details, see "Chapter 8 
Setup Window" > "8.4 File Tab".

Note:	If (2) was selected, use method (1) or (3) to specify the Save As file 
destination and Save as Type.

Click the OK button to save the image data displayed in the Preview 
window.
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•	Performing Auto File Name Generation
If a file name with numerals at the end is specified, the numeral at 
the end of the file name will be automatically incremented by one, 
enabling files to be saved successively without any overwriting.
Auto File Name Generation Procedure
(1)	Specify a file name with numerals at the end (e.g. Sample001).
(2)	Save it. (The file will be saved as Sample001).
(3)	The next time that you save the file, an automatic file name is 

generated with the numeral at the end automatically incremented 
by 1 (e.g. Sample002).
Note:	The numerals will continue to be incremented up to the maximum 

possible limit. Once the limit is reached, the next file name will 
have a 0 at the end (e.g. The file name after Sample999 will be 
Sample000.)

	 Move  
This tool enables the image to be moved freely within the Preview area.
•	Move Procedure

(1)	Click the "Move" button. When the mouse cursor is moved onto the 
image in the Preview window, it changes to a hand shape.

(2)	Click anywhere on the image to move it as desired.
Note:	 If a touch panel is being used for the display, perform the same 

operation by using a finger instead.
Note:	 The Move function can only be used when the image has been enlarged.

	 Fit  
Displays the window on-screen image to fit it in the current window area.

	 1:1  
Displays the image with one dot representing one pixel.

	 Enlarge Area  
Provides an enlarged display of the specified area.
(1)	Click the Enlarge Area button. When the mouse cursor is moved 

onto the image in the Preview window, it changes into a cross.
(2)	Drag to form a rectangle marked by dotted lines and enlarge the 

scope of the area delineated by the rectangle.

	 Enlarge  
Enlarges the image.

	 Reduce  
Reduces the image.
Note:	 The slider between the "Enlarge" and "Reduce" buttons can be used 

to change the ratio. Move it to the right to enlarge the image, and to 
the left to reduce the image.

3.2.2.3	 Setup Area
The setting items for each mode are displayed in the Setup Area.  
For more detailed information, see the following sections:
COPY mode..... Chapter 4 Copying a Document: COPY MODE, Section 4.2 COPY 

MODE functions
PRINT mode..... Chapter 5 Printing a File: PRINT MODE, Section 5.2 PRINT MODE 

functions
SCAN mode..... Chapter 6 Saving Scanned Data to a File: SCAN MODE, Section 6.2 

SCAN MODE functions
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4	 Copying a Document: Copy Mode

Before copying a document
Your scanner and printer must both be connected to your computer before you 
start the copying operation. For further details, see "Chapter 8 Setup Window" > 
"8.2 Scanner Tab" and "8.3 Printer Tab". 

This chapter describes the COPY mode operating procedures and the COPY mode 
functions.

Selects Color 
or B/W

Selects the 
Document Type

Specifies the 
Document Size

Specifies the 
Print Size

Specifies 
the Scaling

Specifies 
the Brightness

Please see subsection "3.2.2 Main Window" for descriptions 
of the Preview Area and the Common Area buttons.

Preview Area 

Common AreaCommon Area

Setup AreaSetup Area

4.1	 Copying a Document
The procedure for making a copy of a document is as follows.
(1)	 Select COPY mode.
(2)	 Load the document in the scanner.
(3)	 Select Color copy or B&W copy.
(4)	 Select the Document Type.
(5)	 Specify the Document Size.
(6)	 Specify the Print Size.
(7)	 Specify the Scaling.
(8)	 Specify the Brightness.
(9)	 Specify the Number of Copies.
(10)	Click the "Copy" button.

(1)	Select COPY mode.
"Select Mode" window.

	 COPY  
Click the "COPY" button in the "Select Mode" window.
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The "COPY MODE" window is displayed.

(2)	Load the document in the scanner.
Place the document to be copied face down in the scanner.

(3)	Select Color copy or B&W copy.

(4)	Select the Document Type.
From the "Standard" or "User Defined" tab, select the type of document that is 
going to be copied.

(5)	Specify the Document Size.
	 Document Size

Click the "Document Size" button to display the "Document Size" window.

Specify the document size, and then click the "OK" button.

(6)	Specify the Print Size
	 Print Size

Click the "Print Size" button to display the "Print Size" window.

Specify the print size, and then click the "OK" button.

(7)	Specify the Scaling.
	 Scaling

Click the "Scaling" button to display the "10Key" window.
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Use the 10Key window to input a numeric value.  
Input the scaling value, and then click the "OK" button.  
The scaling ratio can be set in the range 25 to 400%.  
If the Document Size and Print Size are specified, the Scaling function 
automatically calculates the values for a perfect size match.

(8)	Specify the Brightness
   Brightness

To increase the brightness, click the buttons on the right-hand side. To reduce the 
brightness, click the buttons on the left-hand side.

(9)	Specify the Number of Copies
   Copies

Click the "Copies" button to display the "10Key" window.

Use the 10Key window to input a numeric value.  
Input the desired number of copies, and then click the "OK" button.  
The number of copies that can be specified is a number within the range that can 
be specified for the printer that is being used.

(10) Click the "Copy" button.

   Copy

Copying starts.
Note:	 If a document has not been loaded in the scanner, the "The scanner is not ready" 

error message will be displayed. In this case, load a document in the scanner.
Note:	 Confirm that the print size is not larger than the size of the paper set in the printer.
Note:	 The direction in which the paper is output from the printer changes depending 

on your printer rotation settings. It is recommended that you preview your work 
before printing in order to avoid ruining or wasting printing paper.

Note:	 Output results in copy mode differ greatly depending on your printer driver’
s color adjustment function. Please set your printer driver’s color adjustment 
function and scan settings in accordance with your desired output.

4.2	 Copy Mode Functions

The COPY MODE function descriptions are for the items in the Setup Area at the right-
hand side of the screen.  
For more detailed information, see Section "3.2 Scanning Arts 2 for WIN Window 
Configuration".

Color/B&W

Select Color for a color copy or B&W for a black and white copy.
Color................. Includes full-color images.
B&W................. Includes grayscale and black and white images.
Note:	 The items displayed for "Document Type" vary according to the Color/B&W selection.
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Document Type

Select the type of document to be scanned in.
"Standard" tab..........Recommended settings for various document types.
"User Defined" tab....Use this tab to select a user-defined "Document Type".

Number of user-defined document types that can be specified
35 user-defined document types can be specified for black and 
white and for color documents respectively.
Note:	For further details on how to create user-defined settings see 

"Chapter 7 Document Type: Creating User-defined Settings" > 
"7.2 Creating a User-defined Setting".

Changing Pages
The seven user-defined settings that are displayed at one time on 
the User Defined tab constitute one page. There are 5 pages in total.  
The name of the currently-selected page is displayed on the 
button at the very top of the User Defined tab.

There are two methods of switching from one page to another.
•	Click the  button to display the "Page Select" 

window. Click the page number button you want to display, and 
then click the "OK" button. The selected page is displayed on 
the User Defined tab.

•	Click the  button on the User Defined tab to move to the 
previous page, and the  button to move to the next page.  
The page number of the currently-displayed page out of the 
total number of checked pages in the "Page Select" window is 
displayed between the  and  buttons.

Note:	 If the checkbox at the left of each  button in 
the "Page Select" window has not been checked, that page 
cannot be selected.

Moreover, pages that are not checked are not displayed when 
the  or  button is clicked to move to the previous page 
or to the next page. Only pages for which the checkbox has 
been checked are displayed.

Changing the Page Name
The page name can be changed. To change the name, click any 
of the  buttons in the "Page Select" window and then 
click the "Setup"  button to display the "Page Setting" window.

Input the desired name, and then click the "OK" button.
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Document Size
	 Document Size

Selects the size of the document to be scanned in by the scanner.  
Click the "Document Size" button to display the "Document Size" window.

Select a size, and then click the "OK" button.  
The sizes that can be chosen are as follows. (The currently selected size is displayed 
at the bottom left of the "Document Size" window.)
ISO A................A4 to A0, A0 Carrier sheet, A1 Carrier sheet
JIS B.................B4 to B0
ANSI.................A to E
ARCH...............A to E
DIN...................A4 to A0
USER...............Up to ten user-defined sizes can be registered. User-defined sizes 

cannot be set in this window. See "Chapter 8 Setup Window" > "8.1 
General tab"> "Register User Size" > "Document Size".

Note:	 The document sizes that can be selected depend on the scanner model.
The 10-key buttons located in the Document Size display area can be used to change 
the length and width values.

• Using the 10-key button
   10Key window

The 10-key button is used to display the "10Key" window to enable numeric input.

Print Size
	 Print Size

Selects the size of the paper to be used for printing.  
Click the "Print Size" button to display the "Print Size" window.
Note:	 The document sizes that can be selected depend on the printer model.

Select the print size, and then click the "OK" button.
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Scaling
	 Scaling

Specifies the enlargement/reduction ratio.  
Click the "Scaling" button to display the "10Key" window.

Click the relevant numeric keys to input the desired number, and then click the "OK" button. 
The scaling ratio can be set in the range 25 to 400%.
Note:	 If the Document Size and Print Size are specified, the Scaling function automatically 

calculates the values for a perfect size match.

Brightness
   Brightness

Changes the brightness.  
There are five levels of brightness.  
To increase the brightness, click the buttons on the right-hand side. To reduce the 
brightness, click the buttons on the left-hand side.

Copy

	 Copy

Makes a copy of the document.
Note:	 If a document has not been loaded in the scanner, the "The scanner is not ready" 

error message will be displayed. In this case, load a document in the scanner.
Note: If data that exceeds the size limit is output in COPY mode, multiple copies cannot 

be created. In this case, a "Size limit exceeded. Cannot output the second and 
subsequent prints." message is displayed after the first copy is output. 	
To avoid this type of situation, either reduce the output length or lower the Print 
Quality setting.

Note:	 Confirm that the print size is not larger than the size of the paper set in the printer.
Note:	 The direction in which the paper is output from the printer changes depending on 

your printer rotation settings. It is recommended that you preview your work before 
printing in order to avoid ruining or wasting printing paper.

Note:	 Output results in copy mode differ greatly depending on your printer driver’s color 
adjustment function. Please set your printer driver’s color adjustment function and 
scan settings in accordance with your desired output.

4.3	 What to Do When you Want to...
• Make continuous copies

See "Chapter 8 Setup Window" > "8.1 General Tab" > "Continuous Copy /Scan"

• Make the colors brighter
See "Chapter 7 Document Type: Creating User-defined Settings" > "7.3 Detailed 
Setting Items" > "7.3.2 Scan Settings"
When the document is a black and white document 	
See "7.3.2.1 Document Type (Black and White)" or "7.3.2.2 Document Type 
(Grayscale)" > "Color Adjustment" > "Brightness"
When the document is a color document 	
See "7.3.2.4 Document Type (Full Color)" > "Color Adjustment" > "Brightness (or 
Contrast)"

• Make lines sharper
See "Chapter 7 Document Type: Creating User-defined Settings" > "7.3 Detailed 
Setting Items" > "7.3.2 Scan Settings">"Edge Sharpening"

• Make the background whiter
See "Chapter 7 Document Type: Creating User-defined Settings" > "7.3 Detailed 
Setting Items" > "7.3.2 Scan Settings" > "White Point"

• Change the selected color
See "Chapter 7 Document Type: Creating User-defined Settings" > "7.3 Detailed 
Setting Items" > "7.3.2 Scan Settings" > "7.3.2.4 Document Type (Full Color)" > 
"Modify Color"

• Remove creases in the document
See "Chapter 7 Document Type: Creating User-defined Settings" > "7.3 Detailed 
Setting Items" > "7.3.2 Scan Settings" > "7.3.2.4 Document Type (Full Color)" > 
"Crease Reduction"

• Remove the light stripes that appeared in the scanned data
See "Chapter 7 Document Type: Creating User-defined Settings" >"7.3 Detailed 
Setting Items" > "7.3.2 Scan Settings" < "7.3.2.4 Document Type (Full Color)" > 
"Moir_ Pattern Removal"

• Remove small speckles from the document
See "Chapter 7 Document Type: Creating User-defined Settings" > "7.3 Detailed 
Setting Items" > "7.3.2 Scan Settings" > "Automatic Despeckling"
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5	 Printing a File: Print Mode

Before printing a file
Your printer must be connected to your computer before you start the printing 
operation.  
For further details, see "Chapter 8 Setup Window" > "8.3 Printer Tab".

This chapter describes the PRINT mode operating procedure and the PRINT mode 
functions.

Please see subsection "3.2.2 Main Window" for descriptions 
of the Preview Area and the Common Area buttons.

Preview Area Preview Area 

Common AreaCommon Area

Specifies 
the Scaling

Specifies the 
Print Size

Setup AreaSetup Area

Selects the 
file to print

5.1	 Printing a File
The procedure for printing a file is as follows.
(1)	 Select PRINT mode.
(2)	 Select a file.
(3)	 Specify the Print Size.
(4)	 Specify the Scaling.
(5)	 Specify the Number of Copies.
(6)	 Click the "PRINT" button.

(1) Select PRINT mode.
"Select Mode" window.

	 PRINT  
Click the "PRINT" button in the "Select Mode" window.
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The "PRINT MODE" window is displayed.

(2) Select a file.
	 File

Click the "File" button to display the "Browse" window. Select the file to be printed 
and then click the "Open" button.

(3) Specify the Print Size.
	 Print Size

Click the "Print Size" button to display the "Print Size" window. 

Specify the print size and then click the "OK" button.

(4) Specify the Scaling.
	 Scaling

Click the "Scaling" button to display the "10Key" window.

Use the 10Key window to input a numeric value.  
Input the scaling value, and then click the "OK" button.  
he scaling ratio can be set in the range 25 to 400%.�  
When a file is selected and a "Print Size" specified, scaling is performed 
automatically at a calculation ratio that enables the file size to fit the print size.

(5) Specify the Number of Copies.
   Copies

Click the "Copies" button to display the "10Key" window. 

Use the 10Key window to input a numeric value.  
Input the desired number of copies, and then click the "OK" button.�  
The number of copies that can be specified is a number within the range that can 
be specified for the printer that is being used.

(6) Click the "Print" button.

   Print

Printing starts.
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5.2	 Print Mode Functions

The PRINT MODE function descriptions are for the items in the Setup Area at the 
right-hand side of the screen. The area at the left of the window is the Preview Area, 
and the area at the bottom of the window is the Common Area. For more detailed 
information, see "3.2 Scanning Arts 2 for WIN Window Configuration".

File
	 File

Selects the image file to be loaded.  
Click the "File" button to display the "Browse" window. The file to be printed is selected 
here.  
When a file is selected, the File name, Output size and Color details are displayed 
underneath the "File" button. "Color" is displayed when the file is a 24-bit or 8-bit color 
image, and "B&W" is displayed when the file is a grayscale or black and white image.
Note:	 If you hold down the "Shift" or "Ctrl"  key while clicking on the file, multiple files 

can be selected. 	
When multiple files have been selected, an arrow button is displayed next to the 
"File" button. Click this arrow button to switch a file displayed in the Preview Area, or 
to switch through the information displayed underneath the "File" button.

Note:	 For information on readable file formats, see the section "About File Formats".

Print Size
	 Print Size

Selects the size of the paper to be used for printing.  
Click the "Print Size" button to display the "Print Size" window.
Note:	 The print sizes that can be selected depend on the printer model.

Select the print size, and then click the "OK" button.

Scaling
	 Scaling

Specifies the enlargement/reduction ratio.  
Click the "Scaling" button to display the "10Key" window.

Click the relevant numeric keys to input the desired number, and then click the "OK" 
button.  
The scaling ratio can be set in the range 25 to 400%.
Note:	 When a file is selected and a "Print Size" specified, scaling is performed 

automatically at a calculation ratio that enables the file size to fit the print size.

Print

   Print

Starts printing the file.
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6	 Saving Scanned Data to a File: Scan Mode

Before saving scanned data
Your scanner must be connected to your computer before you start the scanning 
operation. For further details, see "Chapter 8 Settings Window" > "8.2 Scanner 
Tab".

This chapter describes the SCAN mode operating procedure and the SCAN mode 
functions.

Please see subsection "3.2.2 Main Window" for descriptions 
of the Preview Area and the Common Area buttons.

Preview Area Preview Area 

Common AreaCommon Area

Setup AreaSetup Area

Specifies the 
Document Size

Selects 
Color or B/W

Selects the 
Document Type

Specifies 
the Brightness

6.1	 Saving Scanned Data to a File
The procedure for scanning a document and saving the data to a file is as follows.
(1)	 Select SCAN mode.
(2)	 Load the document in the scanner.
(3)	 Select Color or B&W.
(4)	 Select the Document Type.
(5)	 Specify the Document Size.
(6)	 Specify the Brightness.
(7)	 Click the "SCAN" button.

(1) Select SCAN mode.
"Select Mode" window.

	 SCAN  
Click the "SCAN" button in the "Select Mode" window.
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The "SCAN MODE" window is displayed.

(2) Load the document in the scanner.
Place the document to be copied face down in the scanner.

(3) Select Color or B&W.

(4) Select the Document Type.
From the "Standard" or "User Defined" tab, select the type of document that is 
going to be scanned.

(5) Specify the Document Size.
	 Document Size

Click the "Document Size" button to display the "Document Size" window.

Specify the document size, and then click the "OK" button.

(6) Specify the Brightness.
   Brightness

To increase the brightness, click the buttons on the right-hand side. To reduce the 
brightness, click the buttons on the left-hand side.

(7) Click the "Scan" button.

   Scan

Note:	 If a document has not been loaded in the scanner, the "The scanner is not ready" 
error message will be displayed. In this case, load a document in the scanner.

One of the following windows is displayed when the "Scan" button is clicked.
•	If "Full Screen" on the "General" tab in the "Setup" window is not checked, the 

Windows "Save As" window is displayed.
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•	If "Full Screen" on the "General" tab in the "Setup" window is checked, the "Save" 
window is displayed.

Specify the "Save As" destination for the scanned-in image data, and then click 
the "OK" button. The Scan > Save As procedure starts.
Note:	 If the data to be saved exceeded the size limit during a scan operation, the data 

is not saved to a file. In this case, scanning is aborted and the "Failed to save 
data to file" message is displayed.

6.2	 Scan Mode Functions

The SCAN MODE function descriptions are for the items in the Setup Area at the 
right-hand side of the screen. The area at the left of the window is the Preview Area, 
and the area at the bottom of the window is the Common Area. For more detailed 
information, see Section "3.2 Scanning Arts 2 for WIN Window Configuration".

Color/B&W
   Color/B&W

Selects whether to scan in the document as a color document or as a black and white 
document.
Color................. Includes full color and color reduction images.
B&W................. Includes grayscale and black and white images.
Note:	 The items displayed for "Document Type" vary according to the Color/B&W selection.
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Document Type

Selects the type of document to be scanned in.
"Standard" tab..........Recommended settings for various document types.
"User Defined" tab....Use this tab to select a user-defined "Document Type".

Number of User-defined document types that can be specified
35 user-defined document types can be specified for black and 
white and for color documents respectively.
Note:	For further details on how to create user-defined settings, see 

"Chapter 7 Document Type: Creating User-defined Settings" > 
"7.2 Creating a User-defined Setting".

Changing Pages
The seven user-defined settings that are displayed at one time on 
the User Defined tab constitute one page. There are 5 pages in total.  
The name of the currently-selected page is displayed on the 
button at the very top of the User Defined tab.

There are two methods of switching from one page to another.
•	Click the  button to display the "Page Select" 

window. Click the page number button you want to display, and 
then click the "OK" button. The selected page is displayed on 
the User Defined tab.

•	Click the  button on the User Defined tab to move to the 
previous page, and the  button to move to the next page.  
The page number of the currently-displayed page out of the 
total number of checked pages in the "Page Select" window is 
displayed between the  and  buttons.

Note:	If the checkbox at the left of each [ ] button in the "Page 
Select" window has not been checked, that page cannot be 
selected.

Moreover, pages that are not checked are not displayed when 
the  or  button is clicked to move to the previous page 
or to the next page. Only pages for which the checkbox has 
been checked are displayed.

Changing the Page Name
The page name can be changed. To change the name, click any 
of the  buttons to display the "Page Select" window 
and then click the "Setup"  button to display the "Page Setting" 
window.

Input the desired name, and then click the "OK" button.



21

IndexContents Scanning Arts 2 for WIN

OPS125

Document Size
	 Document Size

Selects the size of the document to be scanned in by the scanner.  
Click the "Document Size" button to display the "Document Size" window. 

Select a size, and then click the "OK" button.  
The sizes that can be chosen are as follows. (The currently selected size is displayed 
at the bottom left of the "Document Size" window.)
ISO A................A4 to A0, A0 Carrier sheet, A1 Carrier sheet
JIS B.................B4 to B0
ANSI.................A to E
ARCH...............A to E
DIN...................A4 to A0
USER...............Up to ten user-defined sizes can be registered. User-defined sizes 

cannot be set in this window. See "Chapter 8 Setup Window" > "8.1 
General tab" > "Register User Size" > "Document Size".

Note:	 The document sizes that can be selected depend on the scanner model.
Length Detection......If the "Length Detection" checkbox has been checked, the length 

of the document is automatically detected when the document is 
scanned. The document width at this time becomes the width of 
the specified Document Size.

"Auto" is displayed above the Document Size length parameter 
in the Main window while the "Length Detection" checkbox is 
selected.  
After scanning has been completed, the displayed length is 
updated to the actual scanned length.

The 10-key buttons located in the Document Size display area can be used to change 
the length and width values.

• Using the 10-key button
   10Key window

The 10-key button is used to display the "10Key" window to enable numeric input.

Brightness
   Brightness

Changes the brightness.  
There are five levels of brightness.  
To increase the brightness, click the buttons on the right-hand side. To reduce the 
brightness, click the buttons on the left-hand side.

Scan

   Scan

Scans the document and saves the scanned data.
Note:	 If a document has not been loaded in the scanner, the "The scanner is not ready" 

error message will be displayed. In this case, load a document in the scanner.
One of the following windows is displayed when the "Scan" button is clicked.
•	If "Full Screen" on the "General" tab in the "Setup" window is not checked, the 

Windows "Save As" window is displayed.
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Methods for specifying the Save As destination
The procedure for the Save As destination is as follows:
(1)	 To change the file name of the image to be saved, input a new name in the File 

name box.
(2)	 To change the drive or folder to which the image is saved, specify the drive or 

folder in "Save in".
(3)	 To change the file format of the image to be saved, select a new format from the 

"Save as type" list. The file extension of the new format will be changed to the 
default character string.

Specify the "Save As" destination, and then click the "Save" button. The Scan > Save 
As procedure starts.

•	If "Full Screen" on the "General" tab in the "Setup" window is checked, the "Save" 
window is displayed.

Methods for specifying the Save As destination
The Save As destination can be specified in three different ways as follows:
(1)	 Use the computer keyboard to directly input the Save As destination in the 

"Save as" box.
(2)	 Click the Browse button to display the Browse window and specify a folder.
(3)	 Use the "File Name" tab to specify the file name; the "Save in" tab to specify the 

folder, and the "Save as Type" tab to specify the file format.
Note:	The file name and folder must have been registered in advance to enable the "File 

Name" and "Save in" tabs to be used to specify the Save As destination. In the 
Setup window, register the file name and folder name in the File tab's "Register 
File Name" window and in the "Register Folder" window. For further details, see 
"Chapter 8 Setup Window" > "8.4 File Tab".

Note:	If (2) was selected, use method (1) or (3) to specify the Save As file destination and 
Save as Type. Specify the "Save As" destination, and then click the "OK" button. 
The Scan > Save As procedure starts.

Note:	If the data to be saved exceeded the size limit during a Scan operation, the data is 
not saved to a file. In this case, scanning is aborted and the "Failed to save data to 
file" message is displayed.

6.3	 What to Do When you Want to...
• Make continuous scans

See "Chapter 8 Setup Window" > "8.1 General Tab > "Performing continuous copies/
scans"

• Make the colors brighter
See "Chapter 7 Document Type: Creating User-defined Settings" > "7.3 Detailed 
Setting Items" > "7.3.2 Scan Settings" 
When the document is a black and white document
See "7.3.2.1 Document Type (Black and White)" or "7.3.2.2 Document Type 
(Grayscale)" > "Color Adjustment" > "Brightness"
When the document is a color document
See "7.3.2.3 Document Type (Color Reduction)" or "7.3.2.4 Document Type (Full 
Color)" > "Color Adjustment" > "Brightness (or Contrast)"

• Make lines sharper
See "Chapter 7 Document Type: Creating User-defined Settings" > "7.3 Detailed 
Setting Items" > "7.3.2 Scan Settings" > "Edge Sharpening"

• Make the background whiter
See "Chapter 7 Document Type: Creating User-defined Settings" > "7.3 Detailed 
Setting Items" > "7.3.2 Scan Settings" > "White Point"

• Change the selected color
See "Chapter 7 Document Type: Creating User-defined Settings" > "7.3 Detailed 
Setting Items" > "7.3.2 Scan Settings" > "7.3.2.3 Document Type (Color Reduction)" 
or "7.3.2.4 Document Type (Full Color)" > "Modify Color"

• Remove creases in the document
See "Chapter 7 Document Type: Creating User-defined Settings" > "7.3 Detailed 
Setting Items" > "7.3.2 Scan Settings" > "7.3.2.3 Document Type (Color Reduction)" 
or "7.3.2.4 Document Type (Full Color)" > "Crease Reduction"

• Remove the light stripes that appeared in the scanned data
See "Chapter 7 Document Type: Creating User-defined Settings" > "7.3 Detailed 
Setting Items" > "7.3.2 Scan Settings" > "7.3.2.3 Document Type (Color Reduction)" 
or "7.3.2.4 Document Type (Full Color)" > "Moir_ Pattern Removal"

• Remove small speckles from the document
See "Chapter 7 Document Type: Creating User-defined Settings" > "7.3 Detailed 
Setting Items" > "7.3.2 Scan Settings" > "Automatic Despeckling"
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7.1	 Document Type Setting Window Configuration
The screen configuration of the Document Type Setting window is described here.  
This window comprises two parts: a Preview section (left-hand side) and a Setup 
section (right-hand side).

Preview section (left-hand side)
Original Image Preview

The original image prior to any changes being made is displayed here.

Update Image
   Update Image

Clicking the "Update Image" button changes the Modified Image Preview.

7	"Document Type": Creating User-Defined Settings
Recommended scan settings for various document types are provided on the 
"Standard" tab in "Document Type". Create a user-defined setting if you plan to use a 
document type that is not listed on the "Standard" tab or if you wish to specify optimal 
settings for your document.  
Click one of the "User Settings 1" to "User Settings 7" buttons on the "Document Type" 
> "User Defined" tab and then click the "Setup"  button to display the window for 
making user-defined settings.

Descriptions are provided here for:
• Document Type Setting Window Configuration (Section 7.1)
• Creating a User-defined Setting (Section 7.2)
• Detailed Setting Items (Section 7.3)
• Modify Color Window (Section 7.4)
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Modified Image Preview

Displays the image after the setting values have been changed.

Close
	 Close

Closes the "Document Type Setting" window.

Setup section (right-hand side)
Name

   Name

The currently selected user-defined setting is displayed. The User Settings name can 
be changed if required. Use the keyboard to directly input the new name in the "Name" 
box.

Save
	 Save

Saves the newly-created user-defined setting details.  
The user-defined settings saved here can be selected using the "Document Type" 
"User Defined" tab in the Main window.

Standard
   Standard

Loads the settings for a document type from the "Document Type" "Standard" tab. 
Select the desired document type from the list. Use this function when you want to 
make slight modifications to a standard setting and then save it as a user-defined 
setting.
Note:	The document types displayed in the "Standard" list vary according to whether 

"Color" or "B&W" was selected in the Main window of each mode.

Scan Settings

Sets the document scanning settings.  
The setting items displayed for "Scan Settings" vary according to the document type 
selected for "Standard".
Note:	For further details, see Section "7.3 Detailed Setting Items".

Scan

   Scan

Scans the document, and displays an image in both the "Original Image Preview" and 
the "Modified Image Preview" windows. 
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7.2	 Creating a User-Defined Setting
The procedure for creating a user-defined setting is as follows.
(1)	Display the "Document Type Setting" window.
(2)	Load the setting values of a document type from the "Standard" tab.
(3)	Scan a document.
(4)	Modify the setting values.
(5)	Save the changes.

(1) Display the "Document Type Setting" window.
Click one of the "User Settings 1" to "User Settings 7" buttons on the "Document 
Type" > "User Defined" tab and then click the "Setup"  button to display the 
"Document Type Setting" window.

	 Setup button

(2) Load the setting values of a document type from the "Standard" tab.
To change values to create a user-defined setting based on a standard document 
type, first select a standard document type from the "Standard" list to enable the 
setting to be loaded and then modified.

   Standard

(3) Scan a document.
If there is no image displayed in the "Original Image Preview" or "Modified Image 
Preview" window, click the Scan button to initiate scanning.

   Scan

(4) Modify the setting values.
Change the "Scan Settings" values until you find the optimal values for the 
document. The results of the changes are shown in the "Modified Image Preview" 
window. To modify the preview, click the "Update Image" button.

   Update Image

Note:	For further details, see Section "7.3 Detailed Setting Items".

(5) Save the changes.
Click the "Save" button. The file name displayed for "Name" is the user-defined 
setting just created. The name can be changed.

   Save
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7.3	 Detailed Setting Items
This section describes the detailed setting items for the "Scan Settings".

7.3.1	 Common Settings
These are the settings that are always displayed under "Scan Settings".
Resolution

	 Resolution
Specify the resolution at which image data is scanned in.
Quality

	 Quality
Specify the scan quality at which image data is scanned in.
Note:	The scan quality that can be selected depends on the scanner model.

7.3.2	 Scan Settings
The setting items displayed for "Scan Settings" vary according to the document type 
selected for "Standard". The "Scan Settings" for each of the selected document types 
are as follows.
Please see subsection "7.3.2.1 Document Type (Black and White)" when any of the 
following document types has been selected.
• Maps or Drawings (Black and White)
• Light Blueprint (Black and White)
• Dark Blueprint (Black and White)
• Newspaper
Please see subsection "7.3.2.2 Document Type (Grayscale)" when any of the following 
document types has been selected.
• Maps or Drawings (Grayscale)
• Poster (Grayscale)
• Photo (Grayscale)
Please see subsection "7.3.2.3 Document Type (Color Reduction)" when the following 
document type has been selected.
• Maps or Drawings (Color Reduction)
Please see subsection "7.3.2.4 Document Type (Full Color)" when any of the following 
document types has been selected.
• Photo (Full Color)
• Maps or Drawings (Full Color)
• Maps or Drawings (Enhance Highlighter)
• Poster (Full Color)
• Newspaper

7.3.2.1	 Document Type (Black and White)
There are four black and white document types: "Maps or Drawings (Black and 
White)", "Light Blueprint (Black and White)", "Dark Blueprint (Black and White)", and 
"Newspaper".  
The data is scanned in at two levels, black and white.

Color Adjustment
Perform adjustment in the order "Brightness" > "Brightness Correction" > "Edge 
Adjustment"
(1)	First of all, adjust the Brightness.
(2)	Next, if the document features a lot of contrast, use the "Brightness Correction" 

function to reduce the amount of contrast and produce a sharper image.
(3)	To eliminate the noise generated during "Brightness Correction" and sharpen the 

look of small details and text, use the "Edge Adjustment" function.

• Adjustment using the slider

Move the slider to the right to increase the value, or to the left to decrease the value.
• Keyboard input

Input values directly from the keyboard.
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Brightness
Specifies the brightness of the image.
Setting value range.......1 to 255
Input of setting values...Use the keyboard to input values directly, or move the handle 

on the slider.
Effectiveness.................For a brighter image: Specify a large value.  

For a darker image: Specify a small value
Brightness Correction
Specifies the degree of correction required to sharpen a document with a lot of 
contrast (documents with a lot of grayscale areas).
Setting value range.......0 to 100
Input of setting values...Use the keyboard to input values directly, or move the handle 

on the slider.
Effectiveness.................If 0 has been specified as the value, only the "Brightness" 

setting is available.  
The larger the value, the greater the effect on documents with 
contrast. Note that setting an excessively large value is likely 
to generate noise or speckles.

Edge Adjustment
Sharpens lines and text.
Setting value range.......0 to 100
Input of setting values...Use the keyboard to input values directly, or move the handle 

on the slider.
Effectiveness.................Setting a large value sharpens thin lines, text, etc. Note that 

setting an excessively large value is likely to generate noise or 
speckles at each boundary between a black and a white area.

Black/White Point
Specify the Black Point and White Point values.

Black Point
Setting value range.......0 to 254
Effectiveness.................Use this function when you want to make the background of 

the image blacker.
The Black Point sets the reference value for scanning in the image as black.  
When the Black Point is specified, all values from 0 up to the specified value will be 
scanned in as black.  
To increase the amount of black data, increase the setting value.  
If the data is too black, reduce the setting value.

White Point
Setting value range.......1 to 255
Effectiveness.................Use this function when you want to make the background of 

the image whiter.
The White Point sets the reference value for scanning in the image as white.  
When the White Point is specified, all values from the specified value up to 255 will be 
scanned in as white.  
To increase the amount of white data, reduce the setting value. If the data is too white, 
increase the setting value.

Input of Black/White Point setting values
There are two methods of setting the values: adjustment using the slider or using the 
keyboard to input the values directly.
• Adjustment using the slider

Here a slider with two handles is used. The value increases when the slider is moved 
to the right, and decreases when the slider is moved to the left.  
The left handle specifies the Black Point value, and the right handle specifies the 
White Point value.

• Keyboard Input

For the Black Point, input the value directly in the box labeled "Black Point".  
For the White Point, input the value directly in the box labeled "White Point".

Gray Balance

The three RGB colors are used to scan the document. The blue and yellow colors 
become prominent. This parameter is used for applications such as scanning the 
squares on graph paper.
Note:	This setting can only be specified for the CSX300/510/530/550 model.

Automatic Despeckling

Speckles of the specified size will be removed from the image while the document is 
being scanned in.
Note:	"Speckles" refers to the small spots on the image that look like dust.

Despeckle Size

Sets the size of the speckles that are to be removed by automatic despeckling.
Setting value range.......1 to 30 pixels (in 1-pixel increments).
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Automatic Deskew

If the scanner scans in a document that is skewed, the skewed image will be 
automatically corrected. The automatic deskew operates up to ±7.1°.
Note:	Document quality may give results that differ from expectations.

7.3.2.2	 Document Type (Grayscale)
There are three grayscale document types: "Maps or Drawings (Grayscale)", "Poster 
(Grayscale)", and "Photo (Grayscale)".  
Data is scanned in as an 8-bit image, including the 256-level grayscale.

Color Adjustment

• Adjustment using the slider

Move the slider to the right to increase the value, or to the left to decrease the value.
• Keyboard input

Input values directly from the keyboard.

Gamma
Used to adjust the gamma (intermediate-level area's brightness) level of the image.  
If the Brightness function is used to adjust the brightness of the image, since the 
brightness of the image overall is changed at the same time, there are cases when the 
image's light areas become white and washed out, and the dark areas too black. To 
adjust only the brightness of the intermediate-level light and dark areas of the image 
overall, use the "Gamma" function.
Setting value range.......50 to 500
Input of setting values...Use the keyboard to input values directly, or move the handle 

on the slider.
Effectiveness.................Increasing the value enables the intermediate-level area to be 

scanned in as a bright image.
Brightness
Specifies the brightness of the image.
Setting value range.......0 to 100
Input of setting values...Use the keyboard to input values directly, or move the handle 

on the slider.
Effectiveness.................For a brighter image: Specify a large value.  

For a darker image: Specify a small value.
Contrast
Used to adjust the contrast (depth of color) of the image.
Setting value range.......0 to 100
Input of setting values...Use the keyboard to input values directly, or move the handle 

on the slider.
Effectiveness.................For a high-contrast image: Specify a large value.  

For a low-contrast image: Specify a small value.
Black/White Point
Specify the Black Point and White Point values

Black Point
Setting value range.......0 to 254
Effectiveness.................Use this function when you want to make the background of 

the image blacker.  
The Black Point sets the reference value for scanning in the 
image as black.  
When the Black Point is specified, all values from 0 up to the 
specified value will be scanned in as black.  
To increase the amount of black data, increase the setting 
value. If the data is too black, reduce the setting value.
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White Point
Setting value range.......1 to 255
Effectiveness.................Use this function when you want to make the background of 

the image whiter.  
The White Point sets the reference value for scanning in the 
image as white.  
When the White Point is specified, all values from the specified 
value up to 255 will be scanned in as white.  
To increase the amount of white data, reduce the setting 
value. If the data is too white, increase the setting value.

Input of the Black/White Point setting values
There are three methods of inputting the values: adjustment using the slider, using the 
keyboard to input the values directly or using the "Dropper" button.
• Adjustment using the slider

Here a slider with two handles is used. The value increases when the slider is moved 
to the right, and decreases when the slider is moved to the left.  
The left handle specifies the Black Point value, and the right handle specifies the 
White Point value.

•  Keyboard Input

For the Black Point, input the value directly in the box labeled "Black Point".  
For the White Point, input the value directly in the box labeled "White Point".

•  Using the "Dropper" button

This button can be used when the image is displayed in the Preview window.
Specifying the Black Point
The  button on the left is for the Black Point.  
Click the  button, and then move the cursor over the image. Left-click the mouse to 
designate the color at the mouse position as the Black Point. If you drag the mouse 
and then release the mouse button, the lightest color in the area designated by the 
drag-and-release operation becomes the Black Point.
Specifying the White Point
The  button on the right is for the White Point.  
Click the  button, and then move the cursor over the image. Left-click the mouse to 
designate the color at the mouse position as the White Point. If you drag the mouse 
and then release the mouse button, the darkest color in the area designated by the 
drag-and-release operation becomes the White Point.

Gray Balance

The three RGB colors are used to scan the document. The blue and yellow colors 
become prominent. This parameter is used for applications such as scanning the 
squares on graph paper.
Note:	This setting can only be specified for the CSX300/510/530/550 model.

Edge Sharpening

Sharpens the boundary between the background and the data.
Note:	If background speckles increase when you perform high-resolution scanning, disable 

this parameter.

Automatic Despeckling

Speckles of the specified size will be removed from the image while the document is 
being scanned in.
Note:	"Speckles" refers to the small spots on the image that look like dust.

Despeckle Size

Sets the size of the speckles that are to be removed by automatic despeckling.
Setting value range.......1 to 30 pixels (in 1-pixel increments).

Automatic Deskew

If the scanner scans in a document that is skewed, the skewed image will be 
automatically corrected. The automatic deskew operates up to ±7.1°.
Note: Document quality may give results that differ from expectations.
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7.3.2.3	 Document Type (Color Reduction)
There is one color reduction document type, "Maps or Drawings (Color Reduction)".  
Data is scanned in as an 8-bit color image.
Note:	"Maps or Drawings (Color Reduction)" can only be selected when the "Create 

Document Type" window is displayed from the SCAN mode.

Color Adjustment
Adjusts the colors in the image.  
If RGB is selected, the R (Red), G (Green) and B (Blue) values can be specified at the 
same time.
• If R is selected, the R (Red) value can be specified individually.  
• If G is selected, the G (Green) value can be specified individually.  
• If B is selected, the B (Blue) value can be specified individually.

• Adjustment using the slider

Move the slider to the right to increase the value, or to the left to decrease the value.
• Keyboard input

Input values directly from the keyboard.

Gamma
Used to adjust the gamma (intermediate-level area's brightness) level of the image.  
If the Brightness function is used to adjust the brightness of the image, since the 
brightness of the image overall is changed at the same time, there are cases when the 
image's light areas become white and washed out, and the dark areas too black. To 
adjust only the brightness of the intermediate-level light and dark areas of the image 
overall, use the "Gamma" function.
Setting value range.......50 to 500
Input of setting values...Use the keyboard to input values directly, or move the handle 

on the slider.
Effectiveness.................Increasing the value enables the intermediate-level area to be 

scanned in as a bright image.

Brightness
Specifies the brightness of the image.
Setting value range.......0 to 100
Input of setting values...Use the keyboard to input values directly, or move the handle 

on the slider.
Effectiveness.................For a brighter image: Specify a large value.  

For a darker image: Specify a small value.

Contrast
Used to adjust the contrast (depth of color) of the image.
Setting value range.......0 to 100
Input of setting values...Use the keyboard to input values directly, or move the handle 

on the slider
Effectiveness.................For a high-contrast image: Specify a large value.  

For a low-contrast image: Specify a small value.

Notes on the Gamma, Brightness and Contrast settings
The R (Red), G (Green) and B (Blue) components can either be specified in common 
or individually for the Gamma, Brightness and Contrast settings.

Black/White Point
Specify the Black Point and White Point values.
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Black Point
Setting value range.......0 to 254
Effectiveness.................Use this function when you want to make the background of 

the image blacker.  
The Black Point sets the reference value for scanning in the 
image as black.  
When the Black Point is specified, all values from 0 up to the 
specified value will be scanned in as black.  
To increase the amount of black data, increase the setting value.  
If the data is too black, reduce the setting value.

White Point
Setting value range.......1 to 255
Effectiveness.................Use this function when you want to make the background of 

the image whiter.  
The White Point sets the reference value for scanning in the 
image as white.  
When the White Point is specified, all values from the specified 
value up to 255 will be scanned in as white.  
To increase the amount of white data, reduce the setting 
value. If the data is too white, increase the setting value.

Note on the Black/White Point settings
The Black Point and the White Point can be specified for each of the R (Red), G 
(Green) and B (Blue) components for 8-bit and 24-bit color scanning.

Input of the Black/White Point Setting Values
There are three methods of setting the values: adjustment using the slider, using the 
keyboard to input the values directly, or using the "Dropper" button.
• Adjustment using the slider

Here a slider with two handles is used. The value increases when the slider is moved 
to the right, and decreases when the slider is moved to the left.  
The left handle specifies the Black Point, and the right handle specifies the White Point.
Note:	To set all the RGB values to the same point, click the  button. This enables the 

handles for each of the R (Red), G (Green) and B (Blue) components to be moved 
simultaneously.

To specify the Black Point value as the same value as the RGB value, click the  
button at the left. 	
To specify the White Point value as the same value as the RGB value, click the  
button at the right.

• Keyboard Input

For the Black Point, input the value directly in the box labeled "Black Point".  
For the White Point, input the value directly in the box labeled "White Point".

• Using the "Dropper" button

The "Dropper" button can be used when the image is displayed in the Preview 
window
Specifying the Black Point
The  button on the left is for the Black Point.  
Click the  button, and then move the cursor over the image. Left-click the mouse to 
designate the color at the mouse position as the Black Point. If you drag the mouse 
and then release the mouse button, the lightest color in the area designated by the 
drag-and-release operation becomes the Black Point.
Specifying the White Point
The  button on the right is for the White Point.  
Click the  button, and then move the cursor over the image. Left-click the mouse to 
designate the color at the mouse position as the White Point. If you drag the mouse 
and then release the mouse button, the darkest color in the area designated by the 
drag-and-release operation becomes the White Point.

Modify Color
Enables the colors in the image to be modified.
Note:	For details on the Modify Color window, see Section "7.4 Modify Color Window".

• Color Modification Procedure
(1)	Check the "Modify Color After Scanning" box.
(2)	Scan the document.
(3)	Modify colors in the "Modify Color" window displayed after the document has been 

scanned.
(4)	Save the Modify Color settings made.
(5)	To enable a "Modify Color" setting to be used as a "User-defined" setting, save 

the "Modify Color" setting, specify the saved setting in "Specify Color Modification 
Using a File", and then save it as a "User-defined" setting.
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Modify Color After Scanning

Displays the Modify Color window after the document has been scanned and color 
reduction performed to enable the colors to be modified.

Specify Color Modification Using a File

Specifies a file to which Modify Color settings were saved and modifies the colors after 
the document has been scanned. If this setting is checked, the colors are modified 
automatically after the document has been scanned.
Note:	This function can only be specified when "Modify Color After Scanning" has been 

checked.
Note:	Colors are modified when "Modify Color After Scanning" has been checked. If the 

results have been saved to a file, they are displayed in a list.

File Name
Specifies the Modify Color settings file.

Number of Colors

Specifies the number of colors used for color reduction.

Color Space

This designates Color Space during reading.
sRGB.............................This will use sRGB Color Space to scan.
Adobe RGB...................This will use Adobe RGB Color Space to scan.
Note:	This setting can only be specified for the CSX510/530/550 model.

Edge Sharpening

Sharpens the boundary between the background and the data. 
Note:	If background speckles increase when you perform high-resolution scanning, disable 

this parameter.

Automatic Despeckling

Speckles of the specified size will be removed from the image while the document is 
being scanned in.
Note:	"Speckles" refers to the small spots on the image that look like dust.

Despeckle Size

Sets the size of the speckles that are to be removed by automatic despeckling.
Setting value range.......1 to 30 pixels (in 1-pixel increments).

Automatic Deskew

If the scanner scans in a document that is skewed, the skewed image will be 
automatically corrected. The automatic deskew operates up to ±7.1°.
Note:	Document quality may give results that differ from expectations.

Moiré Pattern Removal

Removes moiré patterns. Select the optimal setting from the list according to the 
strength of the moiré patterns.
Note:	If you specify a large value, the overall image may look fuzzy.

Crease Reduction

Specifies the crease reduction intensity for image processing.
Setting value range.......0 to 255
Input of setting values...Use the keyboard to input values directly, or move the handle 

on the slider
• Adjustment using the slider

Here a slider with one handle is used. The value increases 
when the slider is moved to the right, and decreases when 
the slider is moved to the left.

• Keyboard Input

Input values directly from the keyboard.
Effectiveness.................The higher the value, the greater the degree of processing. 

If 0 is selected as the setting value, Crease Reduction is not 
performed.
Note:	This function is only effective when document has a white 

background.
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7.3.2.4	 Document Type (Full Color)
There are five full-color document types: "Photo (Full Color)", "Maps or Drawings (Full 
Color)", "Maps or Drawings (Enhance Highlighter)", "Poster (Full Color)", and "Newspaper".  
Data is scanned in as a 24-bit color image.

Color Adjustment
Adjusts the colors in the image.  
If RGB is selected, the R (Red), G (Green) and B (Blue) values can be specified at the 
same time.
• If R is selected, the R (Red) value can be specified individually.  
• If G is selected, the G (Green) value can be specified individually.  
• If B is selected, the B (Blue) value can be specified individually.

• Adjustment using the slider

Move the slider to the right to increase the value, or to the left to decrease the value.
• Keyboard input

Input values directly from the keyboard.

Gamma
Used to adjust the gamma (intermediate-level area's brightness) level of the image.  
If the Brightness function is used to adjust the brightness of the image, since the 
brightness of the image overall is changed at the same time, there are cases when the 
image's light areas become white and washed out, and the dark areas too black. To 
adjust only the brightness of the intermediate-level light and dark areas of the image 
overall, use the "Gamma" function.
Setting value range.......50 to 500
Input of setting values ..Use the keyboard to input values directly, or move the handle 

on the slider.
Effectiveness.................Increasing the value enables the intermediate-level area to be 

scanned in as a bright image.

Brightness
Specifies the brightness of the image.
Setting value range.......0 to 100
Input of setting values...Use the keyboard to input values directly, or move the handle 

on the slider.
Effectiveness.................For a brighter image: Specify a large value.  

For a darker image: Specify a small value.

Contrast
Used to adjust the contrast (depth of color) of the image.
Setting value range.......0 to 100
Input of setting values...Use the keyboard to input values directly, or move the handle 

on the slider
Effectiveness.................For a high-contrast image: Specify a large value.  

For a low-contrast image: Specify a small value.

Notes on the Gamma, Brightness and Contrast settings
The R (Red), G (Green) and B (Blue) components can either be specified in common 
or individually for the Gamma, Brightness and Contrast settings.

Black/White Point
Specify the Black Point and White Point values
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Black Point
Setting value range.......0 to 254
Effectiveness.................Use this function when you want to make the background of 

the image blacker.  
The Black Point sets the reference value for scanning in the 
image as black.  
When the Black Point is specified, all values from 0 up to the 
specified value will be scanned in as black.  
To increase the amount of black data, increase the setting value.  
If the data is too black, reduce the setting value.

White Point
Setting value range.......1 to 255
Effectiveness.................Use this function when you want to make the background of 

the image whiter.  
The White Point sets the reference value for scanning in the 
image as white.  
When the White Point is specified, all values from the specified 
value up to 255 will be scanned in as white.  
To increase the amount of white data, reduce the setting 
value. If the data is too white, increase the setting value.

Note on the Black/White Point settings
The Black Point and the White Point can be specified for each of the R (Red), G 
(Green) and B (Blue) elements for 8-bit and 24-bit color scanning.

Input of the Black/White Point Setting Values
There are three methods of setting the values: adjustment using the slider, using the 
keyboard to input the values directly, or using the "Dropper" button.
• Adjustment using the slider

Here a slider with two handles is used. The value increases when the slider is moved 
to the right, and decreases when the slider is moved to the left.  
The left handle specifies the Black Point, and the right handle specifies the White Point.
Note:	To set all the RGB values to the same point, click the  button. This enables the 

handles for each of the R (Red), G (Green) and B (Blue) components to be moved 
simultaneously.

To specify the Black Point value as the same value as the RGB value, click the  
button at the left. 	
To specify the White Point value as the same value as the RGB value, click the  
button at the right.

• Keyboard Input

For the Black Point, input the value directly in the box labeled "Black Point".  
For the White Point, input the value directly in the box labeled "White Point".

• Using the "Dropper" button

The "Dropper" button can be used when the image is displayed in the Preview 
window.
Specifying the Black Point
The  button on the left is for the Black Point.  
Click the  button, and then move the cursor over the image. Left-click the mouse to 
designate the color at the mouse position as the Black Point. If you drag the mouse 
and then release the mouse button, the lightest color in the area designated by the 
drag-and-release operation becomes the Black Point.
Specifying the White Point
The  button on the right is for the White Point.  
Click the  button, and then move the cursor over the image. Left-click the mouse to 
designate the color at the mouse position as the White Point. If you drag the mouse 
and then release the mouse button, the darkest color in the area designated by the 
drag-and-release operation becomes the White Point.

Modify Color
Enables the colors in the image to be modified.
Note:	For details on the Modify Color window, see Section "7.4, Modify Color Window".

• Color Modification Procedure
(1)	Check the "Modify Color After Scanning" box.
(2)	Scan the document.
(3)	Modify colors in the "Modify Color" window displayed after the document has been 

scanned.
(4)	Save the Modify Color settings made.
(5) To enable a "Modify Color" setting to be used as a "User-defined" setting, save 

the "Modify Color" setting, specify the saved setting in "Specify Color Modification 
Using a File", and then save it as a "User-defined" setting.
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Modify Color After Scanning

Displays the Modify Color window after the document has been scanned and color 
reduction performed to enable the colors to be modified.

Specify Color Modification Using a File

Specifies a file to which Modify Color settings were saved and modifies the colors after 
the document has been scanned. If this setting is checked, the colors are modified 
automatically after the document has been scanned.
Note:	This function can only be specified when "Modify Color After Scanning" has been 

checked.

File Name
Specifies the Modify Color settings file.

Edge Sharpening

Sharpens the boundary between the background and the data. 
Note:	If background speckles increase when you perform high-resolution scanning, disable 

this parameter.

Automatic Despeckling

Speckles of the specified size will be removed from the image while the document is 
being scanned in.
Note:	"Speckles" refers to the small spots on the image that look like dust.

Despeckle Size

Sets the size of the speckles that are to be removed by automatic despeckling.
Setting value range.......1 to 30 pixels (in 1-pixel increments)

Automatic Deskew

If the scanner scans in a document that is skewed, the skewed image will be 
automatically corrected. The automatic deskew operates up to ±7.1°.
Note:	Document quality may give results that differ from expectations.

Moiré Pattern Removal

Removes moiré patterns.  
Select the optimal setting from the list according to the strength of the moiré patterns.
Note:	If you specify a large value, the overall image may look fuzzy.

Color Mode

Specifies the hue for scanning.
Photo.............................This hue is suitable for printed materials such as photographs 

and posters.
Drawings.......................This is a suitable hue for maps, drawings, etc.
Note: 	This setting can only be specified for the CS500/510/600/610/CSX300/SK200 model.

Color Space

This designates Color Space during reading.
sRGB.............................This will use sRGB Color Space to scan.
Adobe RGB...................This will use Adobe RGB Color Space to scan.
Note:	This setting can only be specified for the CSX510/530/550 model.

Crease Reduction

Specifies the crease reduction intensity for image processing.
Setting value range.......0 to 255
Input of setting values...Use the keyboard to input values directly, or move the handle 

on the slider
• Adjustment using the slider

Here a slider with one handle is used. The value increases 
when the slider is moved to the right, and decreases when 
the slider is moved to the left.

• Keyboard Input

Input values directly from the keyboard.
Effectiveness............... The higher the value, the greater the degree of processing. 

If 0 is selected as the setting value, Crease Reduction is not 
performed.
Note:	This function is only effective when document has a white 

background.
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7.4	 Modify Color Window

7.4.1	 Modify Color Window
This section describes the "Modify Color" window.  
The "Modify Color" window is displayed when a check has been inserted in "Modify Color 
After Scanning" in the "Document Type Settings" window and the Scan button is clicked.  
The image colors can be modified in this window.

Color Modification Procedure
(1)	Select the color to be modified.
(2)	Specify a Modified Color.
(3)	Update the Image.
(4)	Repeat Steps (1) to (3) until you attain the desired image.
(5)	When the desired image has been attained, click the "Save" button to save the 

Modify Color settings.
(6)	Click the "OK" button to close the Modify Color window.

(1)	Select the color to be modified.
When a color has been selected for modification, it is displayed in the "Original Color" list.  
The color selected in this list is modified.

Select the color to be modified
• Using the "New Color" button

	 New Color

Click the "New Color" button and then select the color to be modified in the "Original 
Image" window.

• Using the Palette
	 Select from Palette

Click the "Select from Palette" button under the "New Color" button to select the 
colors to be modified from the palette.
Note:	This method can only be used when the document type is "Maps or Drawings (Color 

Reduction)".

• Changing colors in a specified region to one color
Left-click the Original Image with the mouse and then drag it to define a rectangle 
enclosing the colors to be modified. All the colors in the rectangle created when the 
mouse button is released become colors to be modified.
Note:	Up to 16 colors can be added in a single operation to the "Original Color" list.
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Add the colors to be modified
• Using the "Add" button

	 Add

Click the "Add" button and then select the colors to be added in the "Original Image" 
window.

• Using the Palette
Click the "Select from Palette" button under the "Add" button to select the colors to 
be modified from the palette.
Note:	This method can only be used when the document type is "Maps or Drawings (Color 

Reduction)".

• Adding colors from a specified region
Left-click the Original Image with the mouse and then drag it to define a rectangle 
enclosing the colors to be added. All the colors in the rectangle created when the 
mouse button is released become colors to be added.
Note:	Up to 16 colors can be added in a single operation to the "Original Color" list.

• Increasing the Allowable Range
Increasing the Allowable Range enables the addition of colors to be modified.

After selecting the color for which the Allowable Range is to be increased, specify 
the allowable range by moving the slider or using the keyboard to directly input the 
value. If "Apply to All Colors" is checked, the Allowable Range changes are applied 
to all the colors in the Original Color list.

Amending a Selected Color
To amend a selected color, double-click a color in the Original Color list to display the 
"Color" window. Select the color once more in this window.

	

Deleting a Selected Color
	 Delete

Select the color to be deleted from the "Original Color" list and then click the "Delete" 
button.

(2)	Specify a Modified Color.
One of the colors selected in Step (1) above can be specified after modification.  
If an Original Color is selected, the first color in the Original Color list is displayed in 
the Modified Color list as a modified color.

This color can be modified by using one of the following methods.
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Amending a Modified Color
To amend a modified color, double-click a color in the Modified Color list to display the 
"Color" window. Select the color once more in this window.

	
Deleting a Modified Color

	 Delete

Select the color to be deleted from the "Modified Color" list and then click the "Delete" 
button.

If a "Modified Color" is deleted from the list, the original color in the "Original Color" list 
is also deleted.

(3)	Update the Image.
This function displays the image after color modification has been performed. 

	 Update Image

Click the "Update Image" button to update the "Modified Image" window.

(4)	Repeat Steps (1) to (3) until you attain the desired image.
If you return to Step (1) and select "New Color", it will be added to the "Original Color" 
and "Modified Color" lists respectively.

The original color from the "Original Color" list for the color selected in the Modified 
Color list is displayed in the "Original Color" list.

(5)	When the desired image has been attained, click the "Save" 
button to save the Modify Color settings.

(6)	Click the "OK" button to close the "Modify Color" window.

7.4.2	 Modify Color Window Configuration
On the left-hand side of the "Modify Color" window are the Original Image Preview and 
Color displays. On the right-hand side of the window are the Modified Image Preview 
and Color displays.

Original Image
The original image, before any modifications are made, is displayed here.

New Color
	 New Color

Selects new colors for color modification.
New Color......... Selects an original color. When a new color is selected, a 

corresponding modified color is set.

	 Palette

Palette..............Select a new color from the palette. When a new color is selected, a 
corresponding modified color is set.
Note:	This method can only be used when the document type is "Maps or 

Drawings (Color Reduction)".
Note:	Please see subsection "7.4.3 Select Color Window".

Add
When a 'New Color" is selected, a color for modification is added.

	 Add

Add...................Adds an Original Color. When a color is selected for addition, it is 
added to the "Original Color" list.

	 Palette

Palette..............Select a color to be added from the palette. When a color is selected 
for addition, it is added to the "Original Color" list.
Note:	This method can only be used when the document type is "Maps or 

Drawings (Color Reduction)".
Note:	Please see subsection "7.4.3 Select Color Window".



39

IndexContents Scanning Arts 2 for WIN

OPS125

Original Color
This is an example of an "Original Color" list.

The original color for the color selected in the "Modified Color" list is displayed in the 
"Original Color" list.

The selected color and the R (Red), G (Green), B (Blue) values for the selected color 
and the Allowable Range are displayed in the list.

Allowable Range

Specifies the allowable range of the Original Color. 
If the allowable range is set to 0

.........Only the colors specified in the "Original Color" list are changed to the colors 
specified in the "Modified Color" list.

If the allowable range is set to 20
.........Colors with RGB values within a range of (20 specified in the "Original Color" 

list are changed to the colors specified in the "Modified Color" list.
If the allowable range is set to 255

......... All the colors are changed to the colors specified in the "Modified Color" list.

Apply to All Colors

If "Apply to All Colors" is checked, Allowable Range changes are applied to all the 
colors in the "Original Color" list.

Modified Image
The modified image is displayed here.

Update Image
	 Update Image

Updates the "Modified Image".

Modified Color

The modified colors are displayed in the "Modified Color" list. The original colors for 
the colors displayed here are displayed in the "Original Color" list.

Modify Other Colors

If "Modify Other Colors" is checked, the colors not selected for the "Original Color" 
list will all be changed to the same color. If the neighboring box is clicked, the "Color" 
window is displayed to enable settings to be made for the modified colors.

Load
	 Load

Loads settings from a previously-saved file. The "Load" window appears to enable 
selection of a file.

Save
	 Save

Saves the current settings to a file. The "Save" window appears to enable assignment 
of a file name.

Preview operations
• To display a specific area of the image
Right-click the image with the mouse and then drag it to define a rectangle. The 
rectangle created when the mouse button is released is displayed to fit the current 
window size.

• To scroll the image
Left-click the Modified Image with the mouse and then drag it.  
The image will be scrolled in the mouse direction. Scrolling can be performed in the 
Original Image window only if the "New Color" or "Add" button has not been clicked.
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7.4.3	 Select Color Window
Clicking the "Select from Palette" button in "Modify Color" displays the "Select Color" 
window.

Click the color to be selected.
Note:	Multiple colors can be selected by pressing the "Shift" or "Ctrl" key while clicking.
Display order.... Changes the color display order. Colors can be displayed in the order 

of index, brightness, or hue.

7.5	 What to do When You Want to....
• Change the tone of a color
See "Chapter 7 Document Type: Creating User-defined Settings" > "7.3 Detailed 
Setting Items" > "7.3.2 Scan Settings" > "7.3.2.3 Document Type (Color Reduction)" 
or "7.3.2.4 Document Type (Full Color)" > "Color Adjustment" > "Gamma, Brightness, 
Contrast"

• Make the colors brighter
See "Chapter 7 Document Type: Creating User-defined Settings" > "7.3 Detailed 
Setting Items" > "7.3.2 Scan Settings" 
When scanning a black and white document 	
See "7.3.2.1 Document Type (Black and White)" or "7.3.2.2 Document Type 
(Grayscale)" > "Color Adjustment" > "Brightness"
When scanning a color document 	
See "7.3.2.3 Document Type (Color Reduction)" or "7.3.2.4 Document Type (Full 
Color)" > "Color Adjustment" > "Brightness (or Contrast)"

• Make lines sharper
See "Chapter 7 Document Type: Creating User-defined Settings" > "7.3 Detailed 
Setting Items" > "7.3.2 Scan Settings" > "Edge Sharpening"

• Make the background whiter
See "Chapter 7 Document Type: Creating User-defined Settings" > "7.3 Detailed 
Setting Items" > "7.3.2 Scan Settings" > "White Point"

• Change the selected color
See "Chapter 7 Document Type: Creating User-defined Settings" > "7.3 Detailed 
Setting Items" > "7.3.2 Scan Settings" > "7.3.2.3 Document Type (Color Reduction)" 
or "7.3.2.4 Document Type (Full Color)" > "Modify Color"

• Remove creases in the document
See "Chapter 7 Document Type: Creating User-defined Settings" > "7.3 Detailed 
Setting Items" > "7.3.2 Scan Settings" > "7.3.2.3 Document Type (Color Reduction)" 
or "7.3.2.4 Document Type (Full Color)" > "Crease Reduction"

• Remove the light stripes that appeared in the scanned data
See "Chapter 7 Document Type: Creating User-defined Settings" > "7.3 Detailed 
Setting Items" > "7.3.2 Scan Settings" > "7.3.2.3 Document Type (Color Reduction)" 
or "7.3.2.4 Document Type (Full Color)" > "Moir_ Pattern Removal"

• Remove small speckles from the document
See "Chapter 7 Document Type: Creating User-defined Settings" > "7.3 Detailed 
Setting Items" > "7.3.2 Scan Settings" > "Automatic Despeckling"
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8	 Setup Window
8.1	 General Tab

Continuous Copy/Scan
Check to enable continuous copying or scanning. When this option has been enabled 
and copying or scanning performed, an "Insert the document" prompt is displayed after 
a document has been scanned. To perform scanning of the next document, load it in 
the scanner. When there are no more documents to scan, click the "Cancel" button.
Note:	This setting is invalid when data is loaded from a file.

Save Image
When "Continuous Copy/Scan" has been checked, check this option to enable 
simultaneous saving of the image to a file.  
When this option has been enabled and the "Copy" button clicked, the "Save As" 
window or the "Save" window is displayed. Specify the "Save as" destination.
Note:	This function can only be used in the COPY mode.
Note:	If the data to be saved exceeded the size limit during a Copy operation, only the data 

that can be saved up to the maximum size is actually saved. In this case, after the 
Copy operation has been completed, the "File exceeded the limit. Not all the data was 
saved." message is displayed.

Note:	This option can be selected when "Continuous Copy/Scan" has been checked.

• If "Full Screen" on the "General" tab in the "Setup" window is not checked, the 
Windows "Save As" window is displayed.

• If "Full Screen" on the "General" tab in the "Setup" window is checked, the "Save" 
window is displayed.

Note:	If "Do not show this window again" has been checked, this window will not be 
displayed from the next and all subsequent scan operations onward. The data will 
be saved to the same folder as the first scan, in the same format. If you specify a 
file name that enables file names to be generated automatically, a file name will be 
automatically generated for the next and all subsequent files.

Performing Auto File Name Generation
If a file name with numerals at the end is specified, the numeral at the end of the file 
name will be automatically incremented by one, enabling files to be saved successively 
without any overwriting.
•	Auto File Name Generation Procedure
(1)	Specify a file name with numerals at the end (e.g. Sample001).
(2)	Save it. (The file will be saved as Sample001).
(3)	The next time that you save the file, an automatic file name is generated with the 

numeral at the end automatically incremented by 1 (e.g. Sample002).
Note:	The numerals will continue to be incremented up to the maximum possible limit. 

Once the limit is reached, the next file name will have a 0 at the end (e.g. The file 
name after Sample999 will be Sample000)
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Note:	If the first file is saved with a name that cannot be used for auto file name 
generation, an "Overwrite?" prompt will be displayed for the next file onward. 
Specify a different file name if you do not want to overwrite the first file.

Note:	If "Do not show this window again" has not been checked, the "Save As" window or 
the "Save" window will be displayed for the next and subsequent scans.

Perform Interpolation When Correcting Images
When the data is grayscale or color data and trapezoidal correction or image 
enlargement/ reduction performed, interpolation is performed to smooth out the data.

Full Screen
Specifies the display method.  
Insert a check to display the whole on-screen image in the full monitor display area.  
Remove the check to display the image in the window area.
Note:	Specify "Full Screen" when using the touch panel.
Note:	If specifying "Full Screen", specify the screen resolution as 1024 x 768.

Unit
The unit can be specified as mm or inch.

Use Work File
When this option has been enabled, the image data from a file or from the scanner is 
saved temporarily to a work file, to optimize memory capacity.
Note:	Use this function when scanning large documents.
Note:	Normally, this function should be left checked.

Compress
Compresses the work file to reduce the disk space used.
Note:	Since specifying "Compress" may cause operations to slow down slightly, this 

function should normally be unchecked.

Specify Folder
Check when specifying a folder to create a work file. To input a file name directly, 
click "Browse" to display the "Browse" window and enable specification of the save 
destination.
Note:	If "Specify Folder" has not been checked, data is saved to a temporary system folder.

Register User Size
Creates user-defined Document Sizes.

Document Size
Registers user-defined document sizes.

Select any one of the user-defined sizes 1 to 10, and then click the "Change" button 
to display the "User-defined Size" setting screen. 

	 Change

When changing the file name, use the keyboard to input a file name and a document 
size, and then click the "OK" button.

Version Info
Displays the Scanning Arts 2 for WIN version information.



43

IndexContents Scanning Arts 2 for WIN

OPS125

8.2	 Scanner Tab

Offset
Shifts the initial scanning start position. Check this function to skip the head margin.

Initial X Position 	
With the upper left corner of the document as the origin point, moves the scanning 
start position the X distance only, in the width direction.
Initial Y Position 	
With the upper left corner of the document as the origin point, moves the scanning 
start position the Y distance only, in the length direction.

Auto Loading
Feeds documents into the scanner automatically. Remove the check if you want to 
load documents manually.
Note:	If the documents are thin, or large, load them manually.

Delay Time
When "Auto Loading" is checked, set the delay time from when the document touches 
the scanner sensor switch to when the feed is actually initiated (in 0.1-s increments). 
If, for example, the delay time has been specified as 15, feed is initiated 1.5 seconds 
after the document touches the sensor switch.

Auto Eject
Specifies how the document is to be moved after being scanned.
None.................The document is not ejected and stops at the position where scanning 

ends.

Eject to Back....The document is ejected to the back of the scanner after scanning has 
been completed.

Front................. The document is fed to the front of the scanner after scanning has 
been completed.

Back................. The document is fed to the back of the scanner after scanning has 
been completed.

Scan Speed
Specifies the document movement speed (including the scanning speed).  
Lower the scanning speed when a delicate (limp) document is scanned, or when it is 
necessary to reduce the scanning load on a document.
Note:	Normally, the standard speed is used.
Note:	As a general rule with scanners, even if the speed is changed there are cases when 

the actual scanning speed does not change.

Scanner Select
Selects the scanner model used.

Make sure check the "Auto Recognition" option and press the "Confirm" button to 
confirm that the scanner is connected.  
When correct connection has been confirmed, click the "OK" button.
Note:	If the connected scanner cannot be located via automatic recognition, uncheck the 

"Auto Recognition" option.	
Then, select the method of connection with the connected scanner.

Adjust
Displays the scanner adjustment window.

Make this adjustment in order to approximate the precision of the scanned drawing 
to that of the original drawing (the precision is finely adjusted in accordance with the 
quality of the paper to be scanned).
Note:	Usually this adjustment is unnecessary.
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Distance Correction
   Distance Correction

Corrects distances as appropriate for the type of document.
Setting range.......... approximately up to 1% (effective until the scanner is turned off)
To use the Distance Correction function, you must first measure a vertical line drawn 
on the document using the following procedure.
(1)	Select a document that contains one or more drawn vertical lines. Copy it in at 600 

dpi in portrait orientation.

(2)	Measure the length of the vertical line on the original document. Define it as x 
(Distance Measured on Document).

(3)	Measure the length of the corresponding vertical line on the copied document. 
Define it as y (Distance Measured After Scanning).

(4)	In the "Scanner Adjustments" window, click the "Distance Correction" button. The 
Distance Correction window is displayed.

(5)	Type in the Distance Measured on Document x and Distance Measured after 
Scanning y values.
Note:	These values must be within the range of distance correction.

(6)	Click the "OK" button to calculate the corrections. Distance correction will take 
effect from the next document scanned.

Joint Fine-adjustment
   Joint Fine-adjustment

Graphtec scanners use multiple rows of sensors. In rare cases, there may be one or 
two overlapping or missing pixels in the data at a joint between the rows of sensors.

Original document Data overlaps Original document Data is missing

In either of these cases, finely adjust the sensor-to-sensor joints using the following 
procedures.
(1)	In the "Scanner Adjustments" window, click the "Joint Fine-adjustment" button to 

display the "Joint Fine-adjustment" window.

(2)	Finely adjust each of the joints.
For overlapping pixels...set a positive value.
For missing pixels..........set a negative value.

	 Usually, set 0 (0 is the factory default setting).
(3)	When you have completed the settings, click the "OK" button.

Trapezoidal Correction
   Trapezoidal Correction

Corrects fine deformations, or shifts, in the direction of feed caused by the scanner 
feeding mechanism.  
If two lines of the same original length in the left and right areas of the drawing are 
scanned in as lines of two different lengths, you can adjust the lengths according to 
the longer line.  
To use the Trapezoidal Correction function, you must first measure a rectangle drawn 
on the document. Prepare a document using the following procedure, and then 
perform measurement.
(1)	Prepare a document with the largest possible drawn rectangle (e.g., frame around 

the drawing) and then make a copy of it with the "Trapezoidal Correction" function 
set to off.
Note: At this time, prepare a document of the same quality and of the same size as the 

drawing to be scanned in. Moreover, when making the copy, make sure that you 
set the same conditions as for the document that you want to scan in.

(2)	On the copied document, measure the lengths of the left, right, and top sides.
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(3)	In the "Scanner Adjustments" window, click the "Trapezoidal Correction" button to 
display the "Trapezoidal Correction" window.

(4)	Type the lengths of the top, left, and right sides of the rectangle measured in Step 
(2) in the boxes labeled Document Width, Length of Left Side, and Length of Right 
Side, respectively.

(5)	Click the OK button. The scanner is set to correct the deformations, or shifts, that 
are caused by its feeding mechanism.
Note:	This function is only effective when a document of the same document quality 

and of the same size as the document used for making the settings is scanned in 
under the same conditions as for that document. If settings are made incorrectly 
the system may be damaged. This function should normally be set to Off. Even 
when it is set to Off, the scanner will perform scanning at the guaranteed precision 
level. To set the Trapezoidal Correction function to Off, input 0 for any one of the 
Document Width, Length of Left Side, and Length of Right Side values.

8.3	 Printer Tab
The setting items displayed vary according to the printer used.  
First of all, click the "Printer Select" button to select the printer you are going to use.

Selecting the Printer
   Printer Select

Select the printer. Click the "Printer Select..." button to display the "Printer Select" 
window.

Select the printer model.  
Select the printer driver from the box labeled "Port". Click the OK button.
Note:	Install the printer driver that you plan to use in advance and then run a test print to 

ensure that printing is performed correctly.
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Printer Setup
   Printer Setup

Displays a "Properties" window for the printer driver that was selected in the "Printer 
Select" window. Use this window to make settings such as the print quality and color 
adjustment settings.
Note:	The printer driver Properties window displayed varies according to the printer used.
Note:	We recommend that you make settings such as the print quality and color adjustment 

settings to suit your copying or printing application.

Position
Centered 	
Prints the scanned-in data with the center point of the data at the center point of the 
printer's output area.
Left Margin 	
Prints the scanned-in data with the left margin shifted towards the right of the 
printer's output area by the specified distance only.
Upper Margin 	
Prints the scanned-in data with the top margin shifted downwards from the printer's 
output area by the specified distance only.

Negative
After the document has been scanned in, image data with the colors inverted is sent to 
the printer for output.

Mirror
After the document has been scanned in, a mirror of the image data (with the left and 
right sides reversed) is sent to the printer for output.

8.4	 File tab

JPEG Image Quality
Specifies the image quality when a file is saved in JPEG format. A low image quality 
reduces the size of the file, but renders a coarser image.

Default Resolution
Specifies the resolution to be used when files with no resolution data are opened.
•	Methods of inputting the setting values

Select from the list box 	
Select from 100, 200, 300, 400, 600, 800.
Keyboard input 	
Input a value in the list box directly. The value can be specified in the range 50 to 
4800 (1 unit).



47

IndexContents Scanning Arts 2 for WIN

OPS125

Register File Name
Registers the file name when image data is saved to a file. Click the "Register File 
Name" button to display the "Register File Name" window.

Registered File Names
.............Displays the registered file names.

Add...................Adds new file names. Click the "Add" button to display the "Save As" 
window. Input the new file name, and then click the "OK" button.

Delete...............Deletes the selected file name from the list of registered file names.  
Click a file name in the list of registered file names to select it, and 
then click the "Delete" button.

Change.............Changes the selected file name.  
Click a file name in the list of registered file names to select it, and 
then click the "Change" button. The "Save As" window is displayed. 
Change the file name, and then click the "OK" button.

•	Performing Auto File Name Generation
If a file name with numerals at the end is specified, the numeral at the end of the 
file name will be automatically incremented by one, enabling files to be saved 
successively without any overwriting.

Auto File Name Generation Procedure
(1)	Specify a file name with numerals at the end (e.g. Sample001).
(2)	Save it. (The file will be saved as Sample001).
(3)	The next time that you save the file, an automatic file name is generated with the 

numeral at the end automatically incremented by 1 (e.g. Sample002).
Note:	The numerals will continue to be incremented up to the maximum possible limit. 

Once the limit is reached, the next file name will have a 0 at the end (e.g. The file 
name after Sample999 will be Sample000.)

Register Folder
Registers a Destination Folder when image data is saved to a file. Click the "Register 
Folder" button to display the "Register Folder" window.

Registered Folders
.............Displays the registered folders.

Add...................Adds new folders. Click the "Add" button to display the "Registered 
Folder" window. Input the new folder name, and then click the "OK" 
button.

Delete...............Deletes the selected folder from the list of registered folders. Click 
a folder in the list of registered folders to select it, and then click the 
"Delete" button.

Change.............Changes the selected folder.  
Click a folder in the list of registered folders to select it, and then click 
the "Change" button. The "Register Folder" window is displayed. 
Change the folder name, and then click the "OK" button.
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9	 File Formats
Scanning Arts 2 for WIN handles all the following file formats, but compatible formats 
vary according to the type of image data.

Bitmap
Saved as Windows bitmap data. The folder extension is BMP.

Bitmap RLE
Saved as Windows RLE compressed format bitmap data.  
The folder extension is BMP. 

CAD Overlay ESP
This format is for CAD Overlay ESP data. The folder extension is RLC
Note:	Resolution information cannot be added to the CAD Overlay ESP data at the time it is 

saved. When using Scanning Arts to save CAD Overlay ESP data, the image data is 
saved as is. To load existing CAD Overlay ESP image data from a file, or to save the 
data under a different file format, select the Tools menu > Options > File Settings tab 
and then save at the resolution specified for the Default Resolution setting.

TIFF Uncompressed MSB
TIFF format, Motorola Big Endian uncompressed format.  
The default extension is .tif

TIFF Uncompressed LSB
TIFF format, Intel Little Endian uncompressed format.  
The default extension is .tif

TIFF G4 MSB
TIFF format, Motorola Big Endian Group 4 MMR compressed format.  
The default extension is .tif

TIFF G4 LSB
TIFF format, Intel Little Endian Group 4 MMR compressed format.  
The default extension is .tif

TIFF Packbits MSB
TIFF format, Motorola Big Endian Packbits compressed format.  
The default extension is .tif

TIFF Packbits LSB
TIFF format, Intel Little Endian Packbits compressed format.  
The default extension is .tif

TIFF CCITT G3 MSB
TIFF format, Motorola Big Endian CCITT Group 3 compressed format.  
The default extension is .tif

TIFF CCITT G3 LSB
TIFF format, Intel Little Endian CCITT Group 3 compressed format.  
The default extension is .tif

TIFF G3 MSB
TIFF format, Motorola Big Endian Group 3 compressed format.  
The default extension is .tif

TIFF G3 LSB
TIFF format, Intel Little Endian Group 3 compressed format.  
The default extension is .tif

TIFF JPEG MSB
TIFF format, Motorola Big Endian JPEG compressed format.  
The default extension is .tif

TIFF JPEG LSB
TIFF format, Intel Little Endian JPEG compressed format.  
The default extension is .tif

CALS G4
CALS TYPE 1 , Group 4 MMR compressed format.  
The default extension is .cg4

PCX
PCX version 5 format.  
The default extension is .pcx

Intergraph G4
Intergraph Group 4 MMR compressed format.  
The default extension is .cit

Sun Raster Uncompressed
Sun Raster uncompressed format.  
The default extension is .ras
Note:	Resolution information cannot be added to the Sun Raster Uncompressed data at the 

time it is saved. When using Scanning Arts to save Sun Raster Uncompressed data, 
the image data is saved as is. To load existing Sun Raster Uncompressed image data 
from a file, or to save the data under a different file format, select the Tools menu > 
Options > File Settings tab and then save at the resolution specified for the Default 
Resolution setting.
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Sun Raster Encode
Sun Raster Encode format.  
The default extension is .ras
Note:	Resolution information cannot be added to the Sun Raster Encode data at the time it 

is saved. When using Scanning Arts to save Sun Raster Encode data, the image data 
is saved as is. To load existing Sun Raster Encode image data from a file, or to save 
the data under a different file format, select the Tools menu > Options > File Settings 
tab and then save at the resolution specified for the Default Resolution setting.

JPEG
Joint Photographic Experts Group compressed format.  
The default extension is .jpg
Note:	Data cannot be saved in the CAD Overlay ESP, TIFF JPEG, PCX or JPEG formats if the 

width or length of the document exceeds the dimensions given below.
Resolution (dpi)	 100	 200	 300	 400	 600	 800	 1200	 1600 	
Length (mm)	 16645	 8322	 5548	 4161	 2774	 2080	 1387	 1040

PDF
PDF (1.3) format files.  
The default extension is PDF.

File format compatibility
	 	: Data can be read and saved.
	 	: Data can only be saved, and only when OFF has been selected for the automatic 

length detection function in the Document Size window.
	 	: Data can be read, but not saved.

Bilevel data Grayscale 
data

8-bit 	
color data 

24-bit 	
color data File format

Bitmap RLE

CAD Overlay ESP

TIFF Uncompressed MSB

TIFF Uncompressed LSB

TIFF G4 • MSB

TIFF G4 • LSB

TIFF Pack Bits • MSB

TIFF Pack Bits • LSB

TIFF CCITTG3 • MSB

TIFF CCITTG3 • LSB

TIFF G3 • MSB

TIFF G3 • LSB

TIFF JPEG • MSB

TIFF JPEG • LSB

CALS G4

PCX

INTERGRAPH G4

Sun Raster Uncompressed

Sun Raster Encode

JPEG

PDF
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